Update Installation Instructions for Huntron Products with Huntron
Workstation 4.3
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To use Huntron Workstation version 4.3 with your existing Huntron hardware it is necessary to install
updates to the Tracker hardware driver, Tracker firmware and Access Prober motor control hardware
driver. This document explains these procedures. Please be aware that this document shows the process

using Windows 7 64bit. If you are using a different version of Windows, the procedure and images may
be slightly different.

Installing the Updated Tracker Model 30/Access Tracker Hardware Driver
Open the Windows Device Manager (contact Huntron or perform an internet search if you do not know

how to locate the Device Manager). Access Probers with an embedded Access Tracker use these same
instructions.

File Action Wiew Help
e= | @ H= e
4 7 Training3-PC
- {8 Computer
» =y Disk drives
» B Display adapters
-4 DVD/CD-ROM drives
» % Human Interface Devices
- ¢ Huntron Devices
L. § Huntron Tracker Model 30
> IDE ATA/ATAPI controllers
» & Keyboards
»- Pl Mice and other pointing devices
»- B Monitors
»- & Metwork adapters
» Wi Portable Devices
> ‘? Ports (COM & LPT)
. J&) Processors

,-% Sound, video and game controllers

[

.8 System devices
» § Universal Serial Bus controllers

Locate the Huntron Devices folder in the Device Manager and the Huntron Tracker Model 30 device as

shown above. Right-click the Huntron Tracker Model 30 device and select Update Driver Software from
the menu as shown below.

=4 Device Manager EE
File Action View Help
e AN MU SN ? Nl AN T

4 = Training3-PC
> Computer

=g Disk drives

> M Display adapters

+ i DVD/CD-ROM drives

» 0% Human Interface Devices
IA--. Huntron Devices

: § Huntron Treekar Madal 20

> g IDE ATA/ATAP]
b 2= Keyboards

» -4 Mice and other
. B Monitors

¥ Network adapt|
. Bl Portable Device
> "f Ports (COM & |
S D Processors

Update Driver Software...
Disable
Uninstall

Scan for hardware changes

Properties

»-% Sound, video and game controllers
> 1M System devices
> g Universal Serial Bus controllers

Launches the Update Driver Software Wizard for the selected device.
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Select the option to “Browse my computer for driver software” as shown below.
. S

s |l Update Driver Software - Huntron Tracker Model 30

How do you want to search for driver software?

: < Search automatically for updated driver software :

H Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation H
settings.

= Browse my computer for driver software
Locate and install driver software manually.

Cancel

A

Select the option to “Let me pick from a list of device drivers on my computer”.
. .

-
@ I Update Driver Software - Huntron Tracker Model 30

Browse for driver software on your computer

Search for driver software in this location:

hd Browse...

[¥] Include subfolders

2 Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device,
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Select the Have Disk... button as shown below.

@ I Update Driver Software - Huntron Tracker Model 30

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Mext. If you have a
J disk that contains the driver you want to install, click Have Disk.

Model

S Huntron Tracker Model 30 (Huntron)

= Huntron Tracker Model 30 (i0 Engineering, Inc)
Huntron Tracker Model 30 (i0 Engineering, Inc)

E This driver has an Authenticode(tm) signature.

Tell me why driver signing is important

Click the Browse button to select the location of the correct driver.

Install From Disk

Insert the manufacturer's installation disk, and then 0
= malee sure that the comect drive is selected below.

Cancel

g

Copy manufacturer's files from:

A - Browse...

Browse to the file located at “C:\Program Files\Huntron Workstation 4.3\Drivers\huntrontracker.inf”
as shown in the image below. If you are using 64bit Windows use “Program Files (x86)” instead of
“Program Files”. Click the Open button to select the “huntrontracker.inf” file.

=4 Locate File I&
Lookin: |, Drivers Qe or |
MName ‘ Date moedified Type Sifs

) Static 0/24/20159:42 AM  File folder
1132 9/24/20159:42 AM  File folder N
) x4 9/24/20159:42 AM  File folder I
| xB6 9/24/20159:42 AM  File folder
4 | CyUsbCOM.inf 3/25/201110:19 AM  Setup Information
4k | hptush.inf 4/1/2014 1:07 PM Setup Information
4k | HS20USBBUS.inf 2/28/20151:52 PM Setup Information =/ o
4k | HS20USBPort.inf 2/28/20151:52 PM Setup Information
i+ | huntrontracker.inf 3/5/2015 1:45 PM Setup Information
=) TkrPXI.i"T =TT i 4/18/2008 7:40 AM  Setup Information l
£ usbyma) JEETB TETTEEN 2/28/20075:04 PM  Setup Information
4k | usbvm3| Date modified: 3/5/2015 1:45 PM 5/22/20127:42 AM Setup Information | 8
< | i | 3
File name: huntrontracker.inf - Open
Files of type: | Setup Information (*inf)
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Make sure the file path looks correct then click the OK button to begin the driver installation.

Install From Disk @

Insert the manufacturer's installation disk, and then -
__-‘.y make sure that the comect drive is selected below.

Copy manufacturer’s files from:

C:Program Files (c86)\Hurtron Workstation 4. 3\Dr

A

You will see the Huntron Tracker Model 30 hardware driver listed. Click the Next button to continue.
. \

@ Il Update Driver Software - Huntron Tracker Model 30

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Next. If you have a
< disk that contains the driver you want to install, click Have Disk.

Show compatible hardware

Model
S Huntron Tracker Model 30

—aJ This driver has an Authenticode(tm) signature.
Tell me why driver signing is important

L

The hardware driver should install and display the window shown below. Click the Close button and the
exit from the Windows Device Manager. Do not power off the Tracker.

. =)

Update Driver Software - Huntron Tracker Model 30

h e

Windows has successfully updated your driver software
Windows has finished installing the driver software for this device:

Huntron Tracker Model 30

= d
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Installing the Updated Tracker Model 30/Access Tracker Firmware

Your Tracker Model 30 should already be powered ON from the previous procedure. Start the Huntron
Workstation version 4.3 software. Browse to the Tools menu and select Maintenance/Tracker Model
30 Diagnostics as shown below. Access Probers with an embedded Access Tracker use these same
instructions.

Options... G W Pl pin
Stimulus... Prober - Prober: Mone Fr
Board Buttons

Sequence Buttons

_TOD side L Compenent/Net Buttons

Maintenance Tracker 2800 Diagnostics

Software Activation... Tracker Model 30 Diagnostics

Tracker 32005 Diagnostics
ProTrack Diagnostics
TrackerPXI Diagnostics
Prober Diagnostics

DFK Camera Diagnostics
Sensoray 2250 Diagnostics

When the Diagnostics start you may see a message indicating that your Tracker firmware is out of date.
Click OK to continue.

===

Serial Number: Check Firmware
MMfg Date: Update Firmware

Wersion: | WS 4.2 Firmware

Verify Hardware | Date of Last Hardware Verification I Update Abort

| Date of Last Al nt: I
Alignment e ignme! I Log Update Debug
Verify Alignment | Date of Last Verification: I

Connected Scanners:

Scanner |l Test Channels:

IIn'rtiaIizing Tracker Model 30...This may take several s
Results:

Copy to Clipboard |
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Click the OK button if your Tracker has been powered ON for 10 minutes. This is just to ensure that the
internal electronics are at a nominal operating temperature.

Serial Mumber: Check Firmware |
Mfg Date: Update Firmware |

Version: | WiiS 4.2 Firmware |
Verify Hardware | Dpate of Last Hardware Verification: l— Update Abort
Alignment Date of Last Alignment: I™ Log Update Debug
Verity Alignmens | Do f Last Veriication e

Connected Scanners: |1 =
Scanner |l Test AUX
Channels: 1 - ’V

[ LineOut [ Trigger Out
Update |

-
Status: Tracker Model 30 Diagnostics
I\nilializing Tracker Model 30... This may take sevef
Results:

Make sure that the Tracker Model 30 has been ON for 10 minutes
.JA before proceeding.

| Copy to Clipboard

Click the Update Firmware button to begin the new firmware upload. You will see a series of status
messages displayed in the Results field. DO NOT power off the unit during the update process.

Serial Number:

Ifg Date: Update Firmware |
Version: | iS5 4.2 Firmware |
enify Hardware Date of Last Hardware \erification: I te Abort

Date of Last Alignment: I

Date of Last Verification: I
Connected Scanners: |1 - l

Channels:

Copy to Clipboard
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When the firmware update is complete you should see the messages in the Results field shown below.

i | —————) |
Serial Number: Check Firmware |
Mg Date: Update Firmware |

Version: | WIS 4.2 Firmware |
Verify Hardware | Date of Last Hardware Verification: I

Alignment | Date of Last Alignment: I [~ Log Update Debug
Verify Alignment | Date of Last Verification: ||

Connected Scanners: I‘I - l
Scanner || Test | ALX
Channels: I 1 - l

[ LineOut [ Trigger Out
[T Lineln I~ Trigger In Update

Status:

Results:

Firmware update run on Thursday, September 24, 2015 at 10:05:36 AM

IF RAM File Updated Successfully

IF EEPROM File Found: C:“Program Files f<86)\Huntron Warkstation 4. 34Fimware wypress-30-v1_16-092115.ic
IF EEFROM File Updated Successfully

Firmware update finished Successfully on Thursday, September 24, 2015 at 10:06:03 AM

View Log Copy to Clipboard | Close |

Click the Close button to exit the Tracker Model 30 Diagnostics.

Return to Huntron Workstation and select the Tools menu/Options. Select the Hardware tab and select
Tracker Model 30 (or Access Tracker for Probers with Tracker inside) from the Tracker menu and USB
from the Tracker Port menu. If you are using a Huntron Scanner, select the correct Scanner from the
Scanner menu. Click the Connect button to connect to your hardware.

Options a b » l
General Hardwars | F‘mberl Color I Scan I Signature I Sequence I Component I Met I Pin I Range I Test I
Hardware Settings
Tracker Prober XY Correction Steps
ITIElcker 30 LI I None LI I 3 - l
Tracker Port Prober Serial Port XY Accuracy (Microns)
uss [E3 comi - Eind [0
Scanner Frame Grabber XY Steps Per Second
| | |[Nere =] I~ Enable Auto Align (NI Visior)  [3000 -]
71 72 Z Steps Per Second
’7 Enabled ’]_ Enabled 16000 =
Z Correction Steps
[T Access (2) USE Grey Camera [ Accuracy Errors m
[~ Tracker 2800 Ranges Only 7 Accuracy (Microns)
0
I DH Minimum Spacing ||
[l Connect L I 100 Mil > l
U
OK (Temporary) Cancel Save (Permanent) Default Tab Values Help
b -
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You should see a message indicating that the connection was successful. Click the OK button to close the
message.

iOpﬁons AN - LR - - ]
I' General Hardware | F‘mberl Color I Scan I Signature I Sequence I Component I Net I Pin I Range I Test I |1
1 Hardware Settings -
Tracker Prober XY Correction Steps
ITIElcker 30 ;I I None ;I I 5 w7 I
Tracker Port Prober Serial Port XY Accuracy (Microns)
uss =1 || com - Find [0 !
Scanner Frame Grabber XY Steps Per Second
IScanner 35 LI I None - l [~ Enable Auto Align (NI Vision) I 3000 - I
— . 79 . Z Steps Per Second
Hardware Connect u
[~ Tracker 2800 Ranges Only Tracker (Tracker 30) and Scanner (Scanner 315) Connected to Port (USBE)
Successfully )
I 9/24/2015 10:07:51 AM III
Huntron Workstation Version 4.3.5745.10516
I untron Workstation Version '
|
I
0K (Temporary) | Cancel | Save (Permanent) | Default Tab Values | Help |

- T T T T T T T

The Connect button should now be labelled Disconnect. Click the Save (Permanent) button to save the
current hardware configuration.

Options hd o l
| General Hardware | F‘mberl Color I Scan I Signature I Sequence I Component I Met I Pin I Range I Test I
Hardware Settings
Tracker Prober XY Correction Steps
ITlac:ker 30 LI INone LI |3 VI
Tracker Port Prober Serial Port XY Accuracy (Microns)
uss = [com - Find 10
Scanner Frame Grabber XY Steps Per Second
IScanner 315 LI INone vl [~ Enable Auto Align (NI Vision) |3|}|}|} vl
71 72 Z Steps Per Second
’]7 Enabled ’]7 Enabled |1EDDD jv
Z Correction Steps
I Lccess (2) USE Grey Camera [ Accuracy Errors m
[~ Tracker 2800 Ranges Only 7 Accuracy (Microns)
50
I DH Minimum Spacing “
QK (Temporary) | Cancel | Save (Permanent) | Default Tab Vzlues Help |
b -

The updates to your Tracker Model 30 or Access Tracker are now complete.
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Troubleshooting a Tracker Model 30/Access Tracker Firmware Update
If you encounter problems while trying to update the Tracker Model 30 firmware, try these steps:

1. Follow the instructions for “Load Tracker Model 30 4.2 Driver” on page 29 of this document. You
may to need to do these steps twice before the driver loads properly. Do not power off the
Tracker when moving to the next step. You can verify the driver version by right-clicking the
device in Device Manager, selecting Properties then select the Driver tab. The driver version
should be 1.2.0.1.

2. Once the 4.2 Driver is installed, follow the instructions “Installing the Updated Tracker Model
30/Access Tracker Hardware Driver” listed above on page on page 2. Do not power off the
Tracker.
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Installing the Updated Tracker 2800/2800S Hardware Driver

Open the Windows Device Manager (contact Huntron or perform an internet search if you do not know
how to locate the Device Manager).

File Action View Help
@@ HEl &

4 = Training3-PC
» -8 Computer

» =g Disk drives
b B Display adapters
> L DVD/CD-ROM drives
b 5 Human Interface Devices
b i Huntron Devices
» g IDE ATA/ATAPI controllers
b-EB Keyboards
b --B Mice and other pointing devices
b ‘__-, Monitors
» - Network adapters
» B Portable Devices
7 Ports (COM & LPT)
b 2 Processors
b -% Sound, video and game controllers
b g8 System devices
b § Universal Serial Bus controllers

Locate the Huntron Devices folder and the Huntron Tracker 2800 device as shown above. Right-click the
Huntron Tracker 2800 device and select Update Driver Software from the menu as shown below.

"~ Device Manager [P
File Action View Help
e | D E e & Bk

424 Training3-PC
> 1M Computer

b - Disk drives
» B Display adapters
=y DVD/CD-ROM drives
ﬂg—‘:. Hurman Interface Devices
Huntron Devices
: i Huntron Tracker Mg-=12200
g IDE ATA/ATAPI controll Update Driver Software...
22 Keyboards Disable
-B Mice and other pointing Uninstall
-‘__IL Meonitors
L Network adapters Scan for hardware changes
KD Portable Devices
T Ports (COM & LPT)
2 Processors
% Sound, video and game controllers
1M System devices

b
.

Properties

5
5
5
5
>

b
5
5
5
5

> i Universal Serial Bus controllers

Launches the Update Driver Software Wizard for the sel
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Select the option to “Browse my computer for driver software” as shown below.

- - W
Update Driver Software - Huntron Tracker Model 2500

How do you want to search for driver software?

= Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings.

= Browse my computer for driver software
Locate and install driver software manually.

Select the option to “Let me pick from a list of device drivers on my computer”.

- e .-
Update Driver Software - Huntron Tracker Model 2800

Browse for driver software on your computer

Search for driver software in this location:

C:\Program Files (86)\Huntron Workstation 4.3\Drivers| - Browse...

Include subfolders

# Let me pick from a list of device drivers on compute
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device,

G
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Select the Have Disk... button as shown below.

- -
| Update Driver Software - Huntren Tracker Model 2800

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Next. If you have a
J disk that contains the driver you want to install, click Have Disk.

Model

53Huntron Tracker 2800 Version: 1.1.0.0 [12/14/2011]
ZHuntron Tracker 2800 Version: 1.2.0.1 [7/31/2013]
[5/Huntron Tracker Model 2800

|;] This driver has an Authenticode(tm) signature.

Tell me why driver signing is important

Click the Browse button to select the location of the correct driver.

r 5
Install From Disk ﬁ
0K

Insert the manufacturer's installation disk, and then
malee sure that the comect drive is selected below.

Copy manufacturer's files from:

A - Browse...

b

Browse to the file located at “C:\Program Files\Huntron Workstation 4.3\Drivers\huntrontracker.inf”

as shown in the image below. If you are using 64bit Windows use “Program Files (x86)” instead of
“Program Files”. Click the Open button to select the “huntrontracker.inf” file.

Al Locate File [
Look in: ; Drivers hd G ? 4 ' I
Name ‘ Date moedified Type Sifs

| Static 9/24/2015 9:42 AM File folder
1 x32 9/24/2015 9:42 AM File folder b
) 9/24/20159:42 AM  File folder I
| %86 9/24/2015 9:42 AM File folder
4% | CyUsbCOM.inf 3/25/201110:18 AM  Setup Information
4 | hptush.inf 4/1/2014 1:07 PM Setup Information
4 | HS20USBBUS.inf 2/28/20151:52 PM Setup Information = |
4k | HS20USBPort.inf 2/28/20151:52 PM Setup Information
i huntrontracker.inf 3/5/2015 1:45 PM Setup Information
5 | ThrPLir fl_ T i 4/18/2008 7:40 AM  Setup Information l
& usbyma) JEE B TETmEEN 3/28/20075:04 PM  Setup Information
4k | usbvm3| Date modified: 3/5/2015 1:45 PM 5/22/20127:42 AM Setup Information | 8
< | i | 3
filename:  huntrortracker.inf -
Files of type: | Setup Information (*inf)

Hardware Update for Workstation 4.3 Instructions
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Make sure the file path looks correct then click the OK button to begin the driver installation.

F B
Install From Disk M

Insert the manufacturer's installation disk, and then

;__‘-_‘_y make sure that the comect drive is selected below.

Copy manufacturer’s files from:
C:Program Files (c86)\Hurtron Workstation 4. 3\Dr

A

You will see the Huntron Tracker 2800 hardware driver listed. Click the Next button to continue.

- a -
Update Driver Software - Huntron Tracker Model 2800

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Next. If you have a
J disk that contains the driver you want to install, click Have Disk.

Show compatible hardware

Model
[SIHuntron Tracker Model 2800

= This driver has an Authenticode(tm) signature. Have Disk...
Tell me why driver signing is important

The hardware driver should install and display the window shown below. Click the Close button and the
exit from the Windows Device Manager.

- . s
Update Driver Software - Huntron Tracker Model 2800

Windows has successfully updated your driver software
Windows has finished installing the driver software for this device:

Huntren Tracker Model 2800
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Installing the Updated Tracker 2800/2800S Firmware
Your Tracker 2800/2800S should already be powered ON from the previous procedure. Start the

Huntron Workstation version 4.3 software. Browse to the Tools menu and select Maintenance/Tracker

2800 Diagnostics as shown below.

File Edit View Actions [Tools| Window Help
Options... i Pl Pin
Stimulus... Prober - Prober: Mone {
Board Buttons
- Sequence Buttons
- Top side L Component/Met Buttons
Maintenance Tracker 2800 Diagnostics
Software Activation... Tracker Model 30 Diagnostics
Tracker 32005 Diagnostics
ProTrack Diagnostics

TrackerPXI Diagnostics
Prober Diagnostics

DFK Camera Diagnostics
Sensoray 2250 Diagnostics

Signature Irnage
|Signatures | Scan | Troubleshest| Tracker | Scanner | Preview | CAD |Image | View Pt

Click the OK button if your Tracker has been powered ON for 10 minutes. This is just to ensure that the

internal electronics are at a nominal operating temperature.

Serial Number: [285-01367
Mfg Date: 04/01/2015

Wersion: IDLL: 1.29 Drver: 1.2 FAW:281F: 118 05: 26

Verify Hardare | Date of Last Hardware Veerification: [07/07/2015 P
Alignmen Date of Last Alignment: Iﬂ?fﬂ7f2m5 I Log Update Debug
Verify Alignment Date of Last Verification: |D7f07f2015
Scanner Test AUX
r
Tracker 2800 Diagnostics

Status:

I\nmalmng Tracker Model 2200
Results:

Make sure that the Tracker 2800 has been OM for 10 minutes before
proceeding.

Copy to Clipboard

Hardware Update for Workstation 4.3 Instructions
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Click the Update Firmware button to begin the new firmware upload. You will see a series of status

messages displayed in the Results field. This process can take several minutes. DO NOT power off the
unit during the update process.

Serial Number: 5 7 Check Firmware |
Mfg Date: 04,01/, Update Firmware |

Version: IDLL: 1.29 Driver: 1.2 FAW:28IF: 118 05 26 WIS 42 Firmware |
Verify Hardware | Date of Last Hardware Verification: [07/07/2015

Alignment | Date of Last Alignment: ID?;’D?IZN&
Verify Alignment | Date of Last Verification: 07/07/2015
Scanner Test BB
| r

. . Undate
St Line Out ™ Trigger Out pdat

| Copy to Clipboard |

Serial Number: IEES-E‘IEE? Check Firmware |

Mfg Date: 04/01/2015 Update Firmware |

‘Version: |DLL: 1.29 Driver: 12 FAW: 281F: 118 05: 26 VWIS 4.2 Firmware |
Verify Hardware | Date of Last Hardware Verification: [07/07/2015

Alignment | Date of Last Alignment: |ummu15
Verify Alignment | Date of Last Verification: 07/07/2015]
Scanner Test v
| r

Line Out[™ Trigger Out Update

Status:

Results:

Firmware update run on Friday, September 25, 2015 at 7:45:46 AM

IF RAM File Updated Successfully

IF EEPRCM File Updated Successfully

05 File Updated Successfully

F/W File Updated Successfully

Firmware update finished Successfully on Friday, September 25, 2015 at 7.55:25 AM

View Log | Copy to Clipboard |

Click the Close button to exit the Tracker 2800 Diagnostics.
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Return to Huntron Workstation and select the Tools menu/Options. Select the Hardware tab and select
Tracker 2800 from the Tracker menu and USB from the Tracker Port menu. If you are using a Tracker
28008, select the Tracker 2800S from the Scanner menu. Click the Connect button to connect to your

hardware.
. - — =
Options
General Hardware | F‘mberl Color I Scan I Signature | Sequence I Component I Met I Pin | Range I Test I
Hardware Settings
Tracker Prober XY Correction Steps
| Tracker 2800 =] || [Nere =l [3 |
Tracker Port Prober Serial Port XY Accuracy (Microns)
fuse = com1 - Fi 10
Scanner Frame Grabber XY Steps Per Second
[Tracker 28005 =l || Nere ~] [T Enable Auto A 3000 -
71 72 Z Steps Per Second
’]_ Enabled ’if Enabled |1EDDD j'
Z Correction Steps
[T Access (2) USB Grey Camera [~ Accuracy E m
I I Tracker 2800 Ranges Only Z Accuracy (Microns) |I
50
DH Minimum Spacing
| Connect [1oomi -]
OK (Temporary) | Cancel | Save (Permanent) | Default Tab Values | Help

You should see a message indicating that the connection was successful. Click the OK button to close the

message.

-
Cptions

General Hardware |F‘mber| Color I Scan I Signature | Sequence Componentl Met I Pin I Range I Test I

Hardware Settings

Tracker Prober XY Correction Steps

| Tracker 2800 =] | | [Nene =l [3 3|
Tracker Port Prober Serial Port XY Accuracy (Microns)
uss =l [com -] Find | [i0

Scanner E o

ITIElcker 28005 Hardware Connect

gar Second
vl

Second
Tracker (Tracker 2800) and Scanner (Tracker 28005) Connected to Port (USBE) j‘
Successfully Steps
I % 9/25/2015 7:57:05 AM & II
v Tracker 2800 Ranges Huntron Workstation Version 4.3.574510516 Microns)

OK (Temporary) Cancel Save (Permanent) Default Tab Values Help

Hardware Update for Workstation 4.3 Instructions
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The Connect button should now be labelled Disconnect. Click the Save (Permanent) button to save the

current hardware configuration.

Options

——

General Hardware |F‘mber| Color I Scan I Signature | Sequence Componentl Met I Pin I Range I Test I

Hardware Settings
Tracker Prober XY Correction Steps
ITlacker 2800 LI I Mone I g - l
Tracker Port Prober Serial Port XY Accuracy (Microns)
Juse =l | |[com = E 0
Scanner Frame Grabber XY Steps Per Second
| Tracker 28005 =l None ~| T Enzble A 3000 =
5 72 Z Steps Per Second
¥ Enable ’7‘, Enable |1EDDD vl
Z Correction Steps
[T Access (2) USE Grey Camera [ Ac m
I ¥ Tracker 2800 Ranges Only Z Accuracy (Microns)
50
DH Minimum Spacing
0K (Temporary) | Cancel | Save (Permanent) | Default Tab Values |

The updates to your Tracker 2800/2800S are now

Hardware Update for Workstation 4.3 Instructions
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Installing Updated Motor Control Drivers for Access Probers
Access Probers will perform better with Workstation 4.3 when the new hardware drivers supplied with

this version are installed.

Open the Windows Device Manager (contact Huntron or perform a web search if you do not know how
to locate the Device Manager).

=

Eile

&= |F| HE

Action  View Help

[he]

4 = Training2-PC

b 78 Computer

b g Disk drives

» B, Display adapters

£ DVD/CD-ROM drives

&:ﬁ Human Interface Devices

@ IDE ATA/ATAPI controllers

% Imaging devices

ZZ Keyboards

-LU! Mice and other pointing devices
A Monitors

¥ Network adapters

I Portable Devices

T3 Ports (COM & LPT)

3 Processors

% Seund, video and game controllers
b M Systemn devices

> i Universal 5erial Bus controllers

Open the Ports folders and locate the HS-20USB device

Update Driver Software.

(= Deice Manager

File

Action  View Help

&= | m| B HE 8B %S

. Right-click the HS20USB device and select

4 = Training2-PC

> M Computer
b - Disk drives
B, Display adapters
b -4 DVD/CD-ROM drives

ﬂﬁ Human Interface Devices
» G IDE ATA/ATAPI controllers
b ﬁ Imaging devices
b-ED Keyboards
b --B Mice and other peinting devices
b I Monitors
»-mF Network adapters

B Portable Devices
4 73 Ports (COM & LPT)

‘? Communications Port (COML)

5" Hs-20USB (COMP
-5 Intel(R) Active M
> Processors
» % Sound, video and g3
b 18 System devices

Disable
Uninstall

> a Universal Serial Bus

Opens property sheet for the cu

Properties

Hardware Update for Workstation 4.3 Instructions
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Select the option to “Browse my computer for driver software” as shown below.

[ ' =]

u [l Update Driver Software - H5-20USB (COM3)

How do you want to search for driver software?

= Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings,

>

Locate and install driver software manually.

Cancel

Select the option to “Let me pick from a list of device drivers on my computer”.

[ : et

@ [l Update Driver Software - H5-20USB (COM3)

Browse for driver software on your computer

Search for driver software in this location:
C:\Program Files (:86)\Huntron Workstation 4.3\ Drivers| - Browse...

[¥]Include subfolders

@ L
This list will show installed driver seftware compatible with the device, and all driver
software in the same category as the device.

Hardware Update for Workstation 4.3 Instructions
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Select the Have Disk... button as shown below.

R ~ =5
il Update Driver Software - H5-20USB (COMQ9)

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Next. If you have a
q,-,,’ disk that contains the driver you want to install, click Have Disk.

Show compatible hardwars

Model

[/ Hs-20UsB
HS-20USB

5] This driver has an Authenticodeftm) signature.

Tell me why driver signing is important

Click the Browse button to select the location of the correct driver.

Install From Disk

Insert the manufacturer's installation disk, and then
— makee sure that the comect drive is selected below.

IH
1 E
4

Copy manufacturer’s files from:

A - Browse...

L

Browse to the file located at “C:\Program Files\Huntron Workstation 4.3\Drivers\HS20USBPort.inf” as
shown in the image below. If you are using 64bit Windows use “Program Files (x86)” instead of
“Program Files”. Click the Open button to select the “HS20USBPort.inf” file.

( = Locate File
Look in: . Drivers - @ ? s [~
Mame ’ Date modified Type Sij=
i386 9/17/2015 2:41 PM File folder —
Static 9/17/2015 2:41 PM File folder
*32 9/17/2015 2:41 PM File folder
. xBd 9/17/2015 2:41 PM File folder
. xB6 9/17/2015 2:41 PM File folder
4% | CyUsbCOM.inf 3/25/201110:19 AM Setup Information =
4% | hptush.inf 4/1/2014 1:07 PM Setup Information
4% | HS20USBBUS.inf 2/28/20151:52PM Setup Information
% HS20USBPortinf 2/28/20151:52 PM  Setup Information
¥ | huntrontracker.inf 3/5/2015 1:45 PM Setup Information
% | TkrPXLinf Type: Setup Information B/2008 7:40 AM  Setup Information B
4] usbvm3Lbinf | 27 325 KB B/2007 5:04 PM  Setup Information
i . Date modified: 2/28/2015 1:52 PM
+¥ | usbvm305.inf .

2/2012 7:42 AM Setup Information il
< | i ]

+
File name: HS20USEPot irf hd
Files of type: | Setup Information (" inf)
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Make sure the file path looks correct then click the OK button to begin the driver installation.

F B
Install From Disk M

Insert the manufacturer's installation disk, and then -
;___-_‘y make sure that the comect drive is selected below.

Copy manufacturer’s files from:
C:Program Files (c86)\Hurtron Workstation 4. 3\Dr

A

You will see the HS-20USB hardware driver listed. Click the Next button to continue.

» . [
I Update Driver Software - H5-20USB (COM3)

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Next. If you have a
q,;d’ disk that centains the driver you want to install, click Have Disk.

Show compatible hardware

Model
[5IHS-20USEB

(5] This driver has an Authenticode(tm) signature. [ Have Disk...

Tell me why driver signing is important

The hardware driver should install and display the window shown below.

R . e
| Update Driver Software - HS-20USEB (COM3)

Windows has successfully updated your driver software

Windows has finished installing the driver software for this device:

H5-20USB

Click the Close button and return the Windows Device Manager.

Hardware Update for Workstation 4.3 Instructions



Open the Universal Serial Bus controllers folders and locate the HS-20USB device
HS20USB device and select Update Driver Software.

‘ =)
File Action View Help
=/ E HE &R %Y

> -l Monitors
> ¥ Network adapters
» Il Portable Devices
57 Ports (COM & LPT)
>-n Processors
» @ Sound, video and game contrallers

> -{Ml System devices

s ﬂ Universal Serial Bus controllers
- |§ Generic USE Hub

¢ Generic USE Hub
§ Generic USE Hub
-[§ Hs-20
Update Driver Software...
- § Intel(R) [ lanced Host Controller - 1C2€

Disable anced Host Controller - 10205
Uninstall

Scan for hardware changes

Properties

Select the option to “Browse my computer for driver software” as shown below.

==

-

) 1l Update Driver Software - HS-20USB

How do you want to search for driver software?

< Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings.

EY

Locate and install driver software manually.

Cancel

Hardware Update for Workstation 4.3 Instructions
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Select the option to “Let me pick from a list of device drivers on my computer”.
i _

@ Il Update Driver Software - H5-20USB

Browse for driver software on your computer

Search for driver software in this location:

C:\Program Files (86)\Huntron Workstation 4.3\Drivers| - Browse...

[¥]Include subfolders

& Let me pick from a list of device drivers on compute
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.

Select the Have Disk... button as shown below.

- -
Update Driver Software - H5-20US8

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Mext. If you have a
<P  diskthat contains the driver you want to install, click Have Disk.

Model
53/ HS-20UsSB

=] This driver has an Authenticode(tm) signature,

Tell me why driver signing is important

Click the Browse button to select the location of the correct driver.

F Bl
Install From Disk u
OK

Insert the manufacturer’s installation disk, and then
malee sure that the comect drive is selected below.

Copy manufacturer's files from:

A\ - Browse...
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ra Locate File ﬂl
Look in: Drivers P <] ¥ B -
Name = Date modified Type Si
. amdbd 9/17/2015 2:41 PM File folder
,i386 9/17/2015 241 PM  File folder
J Static 9/17/2015 241 PM  File folder
1132 9/17/2015 2241 PM File folder
| ub4 9/17/2015 2241 PM File folder L
xB6 9/17/2015 2:41 PM File folder 1
& CyUsbCOM.inf 3/25/201110:19 AM  Setup Information
= | hptusb.inf 4/1/2014 1:07 PM Setup Information
i+ | HS20USBBUS.inf 2/28/20151:52 PM Setup Information
4 | HS20USBPart.inf 2/28/20151:52 PM Setup Information
% huntrontracker.i| Type: Setup Information 1015 1:45 PM Setup Information b
| ThiP¥Linf Size: 5,33 KB 2008 7:40 AM  Setup Information
&) usbumsbint Date modified: 2/28/2015 1:92 P o007 5:04 M Setup Information 2
< n (2
Flemame:  HS20USBBUS if -
Files of type: | Setup Information (7inf)

Make sure the file path looks correct then click the OK button to begin the driver installation.

Install From Disk [

Ingert the manufacturer's installation disk, and then
make sure that the comect drive is selected below.

=

Copy manufacturer’s files from:

C:Program Files fc86)\Hurtron Workstation 4 3\Dr

A

You will see the HS-20USB hardware driver listed. Click the Next button to continue.

- - ﬂ
Update Driver Software - H5-20USB !

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Next. If you have a
6’ disk that contains the driver you want to install, click Have Disk.

Show compatible hardward

Model
[SHs-20usB

_ﬁj This driver has an Authenticode(tm) signature,

Tell me why driver signing is important

Browse to the file located at “C:\Program Files\Huntron Workstation 4.3\Drivers\HS20USBBUS.inf” as
shown in the image below. If you are using 64bit Windows use “Program Files (x86)” instead of
“Program Files”. Click the Open button to select the “HS20USBBUS.inf” file.

The hardware driver should install and display the window shown below. Click the Close button and the

exit from the Windows Device Manager.

Hardware Update for Workstation 4.3 Instructions
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"~ - e
Update Driver Software - H5-20USB

Windows has successfully updated your driver software

Windows has finished installing the driver software for this device:

HS5-20U5B

Additional Note for Huntron Access Prober users: When you installed the Workstation 4.3 you were
prompted to install Camera Drivers for your Access Prober. If you did not install these software

packages, we recommend you do so. This will install the latest versions of the software from their
manufacturers.

Hardware Update for Workstation 4.3 Instructions

26



Tracker Model 30 Firmware Back to 4.2

Your Tracker Model 30 should be powered ON. Start the Huntron Workstation version 4.3 software.
Browse to the Tools menu and select Maintenance/Tracker Model 30 Diagnostics as shown below.
Access Probers with an embedded Access Tracker use these same instructions.

Options... " P pin

Stimulus... Prober - Prober: Mone Fr

[Offset | Align | Teach | 7
ﬂﬂﬂ@g

Board Buttons

Sequence Buttons

[ Neme [OrderN
_ Top side 1

Component/Met Buttons al el ol

Tracker 2800 Diagnostics

Maintenance

Software Activation...

Tracker Model 30 Diagnostics puse
Tracker 32005 Diagnostics -
ProTrack Diagnostics

TrackerPXI Diagnostics
Prober Diagnostics

DFK Camera Diagnostics
Sensoray 2250 Diagnostics

Click the OK button if your Tracker has been powered ON for 10 minutes. This is just to ensure that the
internal electronics are at a nominal operating temperature.

@ Tracker Model 30 Diagnestics 4,3.8042,13912 - O #
Serial Number [eHt0000T Check Firmware
Mfg Date: W Update Firmware
Version: IDLL. 1.31 Driver: 1.2 F/W: 1.711F: 1.16 0S5: 0.00 WIS 4.2 Firmware

Venify Hardware | page of | ast Hardware Verification: IW Update Abort

Alignment Date of Last Alignment: |12/13/2021 CTre——
Verify Alignment Date of Last Verification: Iu?/w,/zm?
Connected Scanners: |1
Scanner |l Test Channel ] AUX
nnels: -
™ LineOut [~ Trigger Out
D Lineln I Triggerin  — L

Status:

Results:

Tracker Model 30 Diagnostics

Make sure that the Tracker Model 30 has been ONfor 10
minutes before proceeding.

View Log | Copy to Clipboard
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Click the WS 4.2 Firmware button to begin the new firmware upload. You will see a series of status
messages displayed in the Results field. DO NOT power off the unit during the update process.

@ Tracker Model 30 Diagnostics 4.3.8042,13912

Serial Number: BH1-00001 Check Firmware

IMfg Date:

Update Firmware

Wersion: [DLL: 1.31 Driver: 1.2 FAW: 1.71 IF: 1.16 05: 0.00 WIS 42 Firmware

Verify Hardware | paie of | ast Hardware Verification: [01/24/2007

il

Alignment Date of Last Alignment: 12/13/2021 ™ Log Update Debug
Vesify Alignment Date of Last Verification: 07/17/2017
Connected Scanners: |1 =
Scanner || Test AUX
Channels: 1 -
[~ LineOut [ Trigger Out
Update
Status: = =
Results:

View Log Copy to Clipboard Close

@) Tracker Model 30 Diagnostics 4.3,8042.13912 — O X
Serial Mumber: BH1-00001 Check Firmware
Mfg Date:

Update Firmware
Version: |Unable to Read from W/S 4.2 fimware WIS 4.2 Firmware

Verify Hardware | Date of Last Hardware Verification: [01/24/2007
Al Diate of Last Ali t: 1241372021
Alignment LIS TETIET ™ Log Update Debug
Dl Date of Last Verification: A17/2017]
Connected Scanners: |1 -
Scanner || Test | AUX
Ch ls: 1 -
[~ LineOut [ Trigger Out
Update
Status: = =
Results:

W5 4.2 Firmware update run on Tuesday, February 15, 2022 at 6:34:07 AM

IF EEPROM File Found: C:\Program Files (x86) Hurtron Workstation 4.3'Fimware Tracker 30.iic

IF EEPROM File Updated Successfully

Firmware update finished Successfully on Tuesday, February 15, 2022 at 6:34:08 AM

Restart the Tracker Model 30 after exiting diagnostics and then update the driver to the Workstation 4.2 driver!

View Log | Copy to Clipboard | Close

Click the Close button to exit the Tracker Model 30 Diagnostics and turn off the Tracker Model 30.

Connect the Model 30 to a PC with version 4.2 installed. If the Tracker does not operate correctly. See
Tracker Model 30 Load 4.2 Driver instructions below.

Hardware Update for Workstation 4.3 Instructions
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Tracker Model 30 Load 4.2 Driver
Open the Windows Device Manager (contact Huntron or perform an internet search if you do not know

how to locate the Device Manager). Access Probers with an embedded Access Tracker use these same

instructions.

Locate the device for the Tracker Model 30. It may be “Unknown Device”. To verify it | the correct
device, turn off the Tracker Model 30 and back on. The device that unloads and reloads in Device

B Teve Ma:g:r—_
File Action View Help
= m|H e .
4 7 Training3-PC

> -8 Computer
>y Disk drives

- B Display adapters
-4 DVD/CD-ROM drives
»-0% Human Interface Devices
4- | Huntron Devices
‘.- § Huntron Tracker Model 30
> g IDE ATA/ATAPI controllers
, 2= Keyboards
>l Mice and other pointing devices
> B Monitors
.8 Network adapters
» Il Portable Devices
, T3 Ports (COM & LPT)
> J2 Processors
»-%| Sound, video and game controllers
- M System devices
.+ §§ Universal Serial Bus controllers

manager is the correct device. Right-click the device and select Update Driver Software from the menu

as shown below.

Do Ma;ag:;—_‘
File Action View Help
=% 0B HE 8 F&b

4 = Training3-PC
b Computer
Disk drives
Display adapters
s DVD/CD-ROM drives
a3 éﬁ Human Interface Devices
A--a Huntron Devices
¢ .['§ Huntron Trackar bindal 30

=, i IDE ATA/ATAP Update Driver Software...

, .z Keyboards Disable

CF

> -/ Mice and othe Uninstall

. B Monitors

> ¥ Network adapti Scan for hardware changes
. &I Portable Devic .

L% Ports (COM & Properties

» I Processors

S -3 Sound, video and game controllers
b 7B System devices

>~ § Universal Serial Bus controllers

Launches the Update Driver Software Wizard for the selected device.

Hardware Update for Workstation 4.3 Instructions
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Select the option to “Browse my computer for driver software” as shown below.
. .

</ Il Update Driver Software - Huntron Tracker Model 30

How do you want to search for driver software?

: < Search automatically for updated driver software :
Windows will search your computer and the Internet for the latest driver software |
for your device, unless you've disabled this feature in your device installation :
settings.

2 Browse my computer for driver software
Locate and install driver seftware manually.

Cancel

Select the option to “Let me pick from a list of device drivers on my computer”.
. .

-
@ [l Update Driver Software - Huntron Tracker Model 30

Browse for driver software on your computer

Search for driver software in this location:

- Browse...

[¥] Include subfolders

2 Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.

Hardware Update for Workstation 4.3 Instructions
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Select the Have Disk... button as shown below.

r N
)
@ |l Update Driver Software - Huntron Tracker Model 30

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Next. If you have a
< diskthat contains the driver you want to install, click Have Disk.

Model

@Huntron Tracker Model 30 (Huntron)
[3/Huntron Tracker Model 30 (i0 Engineering, Inc)
_ﬁJHuntrUn Tracker Model 30 (i0 Engineering, Inc)

| This driver has an Authenticode(tm) signature.

Tell me why driver signing is important

Click the Browse button to select the location of the correct driver.

- ~
Install From Disk @

Insert the manufacturer's installation disk, and then 0
== make sure that the comect drive is selected below.

II

Cancel

Copy manufacturer’s files from:

= - Browse...

L

Browse to the file located at either “C:\Program Files (x86)\Huntron Workstation\Drivers\tkr.inf” or
“C:\Program Files (x86)\Huntron Workstation 4.3\Drivers\4-2 Drivers\tkr.inf” as shown in the image
below. Click the Open button to select the “tkr.inf” file.

& Locate File >
Look in: ‘ Drivers v | e ¥ mr

* Name . Date modified Ty ™
) xB4 1/17/2022 6:48 AM Fil
Cukckacees %86 1/17/2022 6:48 AM Fil
- ):_.I CyUsbCOM.inf 3/25/2011 10:19 AM Se
>d hptusb.inf 4/1/2014 1:.07 PM Se
Desktop | HS20USBBUS.inf 2/28/2015 1:52 PM Se

H520USBPort.inf 2/28/2015 1:52 PM Se

[ | >J Huntren_Prober.inf 10/6/2017 2:25 PM Se
Libraries | huntrontracker.inf 3/5/2015 1:45 PM Se
. thrinf 7/31/2013 9:43 AM Se
[! DY inf - 4/18/2008 7:40 AM Se
This PC Type: SEEu'fBlnfcrmatlcn 3/28/2007 5:04 PM Se
‘ odified: 7/31/2013 3:43 AM 5/22/2012 7:42 AM Se
W
L# £ >
Metwark
File name: ther.inf ~ | | Open
Files of type: Setup Information (*inf) Cancel
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Make sure the file path looks correct then click the OK button to begin the driver installation.

r

Install From Disk

ez

Insert the manufacturer’s installation disk, and then
— make sure that the comect drive is selected below.

Copy manufacturer’s files from:

C:\Program Files (x86)Huntron Workstation 4 3\Dr

o]

You will see the Huntron Tracker Model 30 hardware driver listed. Click the Next button to continue.

r

=y

@ [l Update Driver Software - Huntron Tracker Model 30

S

Show compatible hardware

Select the device driver you want to install for this hardware.

Select the manufacturer and model of your hardware device and then click Next, If you have a
6’ dick that contains the driver you want to install, click Have Disk.

Model
[ZHuntron Tracker Model 30

—aJ This driver has an Authenticode(tm) signature.

Tell me why driver signing is important

The hardware driver should install and display the window shown below. Click the Close button and the

exit from the Windows Device Manager.

-

SR

Update Driver Software - Huntron Tracker Model 30

=)

Huntron Tracker Model 30

Windows has successfully updated your driver software

Windows has finished installing the driver software for this device:

Hardware Update for Workstation 4.3 Instructions
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